
LESSON THREE: THE POSSIBILITY OF  
FREEDOM FOR SLAVES 

 
 
INTRODUCTION 
 In 1775, Lord Dunmore, the last royal governor of Virginia, issued a proclamation 
offering freedom to any slave or indentured servant willing to bear arms and fight for the British. 
In this activity, students will examine Dunmore’s Proclamation and use other primary sources to 
determine Virginians’ reaction to the proclamation. 
 
OBJECTIVES 
As a result of this lesson, students will be able to: 

1. Analyze primary source documents to complete an issue analysis. 
2. Explain how Dunmore’s Proclamation challenged the institution of slavery.  
3. Identify the potential consequences of Dunmore’s Proclamation for all the parties  

involved—black and white, British and Virginian. 
 
MATERIALS NEEDED 

Teacher Reference—Background Information on Dunmore’s Proclamation 
Transcription of Dunmore’s Proclamation 
Letter to the Virginia Gazette Regarding Dunmore’s Proclamation 
LearningCheck™ Files: BACKGR, GUIDE, SOURCES, and ASSESS 
Class set of TI-83 Pluses or TI-83 Plus Silver Editions 
TI-Navigator™ Classroom Learning System 
LearningCheck™ Application for the TI-83 Plus and TI-83 Plus Silver Edition 
LearningCheck Creator™ 
Class set of TI-Keyboards 
TI-Navigator Instructions Tip Sheet (optional) 

 
 
PROCEDURE 
 
SETTING THE STAGE 

1. Distribute copies of the Transcription of Dunmore’s Proclamation to students. 
 
2. Give students the BACKGR LearningCheck™ file containing teacher-generated 

questions. Have students access the file. (Additional instructions for using the 
LearningCheck™ application are available on the LearningCheck™ Tip Sheet.): 

a. The first four questions are general comprehension multiple-choice questions 
about the document, with the first question being “What is the main idea of the 
document?” 

b. Question five is an open response question asking students to provide supporting 
material for the main idea drawn from the document.  
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3. After students have responded to the questions in the BACKGR LearningCheck™ file, 
use the Class Analysis function of the TI-Navigator™ system to review their responses.  

 
STRATEGY 

1. After reviewing the questions and checking comprehension, inform students that they 
will be discussing Virginians’ reaction to Dunmore’s Proclamation. 

 
2. Have students access the GUIDE LearningCheck™ file. This file is a series of ten 

statements with which students will agree or disagree as an Anticipation Guide. All 
answers should be phrased as opinion statements regarding what students think will 
happen and the effect Dunmore’s Proclamation may have on all of the involved parties. 

 
3. Ask students to use their ten opinion statements to create a prediction about the effect(s) 

of Dunmore’s Proclamation. [NOTE: Students will return to these statements at the end 
of the activity to determine if their assessment of the situation was correct.] 

 
4. Give students copies of the Transcription of Dunmore’s Proclamation and the Letter to 

the Virginia Gazette Regarding Dunmore’s Proclamation. Instruct them to open the 
SOURCES LearningCheck™ file containing the following questions: 

 
A multiple-choice question. “What issue does Dunmore’s Proclamation address? 

Choice 1: Freedom for the slaves 
Choice 2: Governor Dunmore’s threat against the colony of Virginia 
Choice 3: Governor Dunmore needs troops 
Choice 4: Governor Dunmore is opposed to slavery 
Choice 5: Not enough information to express an opinion 

 
Directed Reading Thinking (DRT) questions. Brief response comprehension questions 
designed to help lead students through the sources: 

•  How has examining these primary sources changed your point of view? 
•  What else do you need to know? 
•  What is the Dunmore’s Proclamation about? 
•  What does the proclamation offer? 
•  Which slaves is the offer being made to? 
•  What restrictions are being placed on the offer? 
•  What would argue in favor of accepting the proclamation? 
•  What would argue against accepting the proclamation? 
•  Why did so few slaves accept the offer? 
•  Is Dunmore’s Proclamation being used as a weapon? 
•  What is the implied threat? 
•  Who is this threat directed against? 
•  What do the people being threatened fear most? 
•  How is the British government using that fear? 
•  How is the threat tied to the Virginia economy? 

 

© 2003 Colonial Â 2



5. Debrief students. Their responses to the questions can be displayed using the Slide Show 
feature in Class Analysis. Return to the GUIDE LearningCheck™ file and have students 
answer the questions again. How did their opinions change as a result of their research? 

 
EVALUATION 

1. Conduct a whole-class discussion using the following question as the prompt:  
 Did reading Dunmore’s Proclamation and/or the letter to the Virginia Gazette  
 regarding the proclamation influence your thinking about the American  
 Revolution, either positively or negatively?  

  
2. Have students open the ASSESS LearningCheck™ file. Have each student assume 

one of the following roles and write a paragraph identifying actions they would take 
regarding Dunmore’s Proclamation. Students must defend their choice(s).  

 
ROLES: 

A fence-sitter 
A patriot slave owner 
A loyalist slave owner 
A black adult male slave 
A black adult female slave 
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TEACHER REFERENCE—BACKGROUND INFORMATION ON  
DUNMORE’S PROCLAMATION 

 
In November of 1775, Virginia’s royal governor, John Murray, fourth Earl of Dunmore, 

issued a proclamation in response to information that the colonists had begun forming armies and 
attacking British troops. Dunmore wanted to put a quick end to the fighting and other activities 
he considered traitorous. Known as “Dunmore’s Proclamation,” the governor’s announcement 
created a fervor among the populace and may have actually helped secure the alignment of many 
moderate or undecided white Virginians against the British government. The proclamation 
declared Virginia in a state of rebellion and placed the colony under martial law. The most 
offensive portion of the document, though, was the section that offered freedom to slaves and 
bonded servants of patriot sympathizers and forces if they were willing to bear arms and fight for 
the British. 

Dunmore’s strategy was one that he had considered before. In a 1772 report to Lord 
Dartmouth, the British secretary of state for the colonies, Dunmore had suggested that in case of 
war with foreign powers, the colonists “trembled at the facility that an enemy would find in 
procuring Such a body of men.” Dunmore had further expressed a belief that the slaves would 
rise up in huge numbers against their masters “and therefore are ready to join the first that would 
encourage them to revenge themselves.”2 Shortly after the Gunpowder Incident in April 1775,3 
Dunmore threatened the mayor of Williamsburg by stating that he would destroy the town and 
“proclaim liberty” for slaves in response to civil unrest. 

Dunmore misunderstood the slaves’ potential motivation. It was not the opportunity to 
avenge themselves that caused them to join the British, it was the desire to secure freedom. 
Noted historian Dr. Benjamin Quarles assessed that the slaves “reserved allegiance for whoever 
made them the best and most concrete offer.”4 The fact that Dunmore was basically in exile on 
board a ship did little to motivate large numbers to join him, but nonetheless, a considerable 
number made the attempt. When a slave owned by Robert Brent in the Northern Neck of 
Virginia escaped, Brent noted that the slave’s action “was long premeditated.” Brent also stated 
that the slave’s escape “was from no cause of complaint. . . but from a determined resolution to 
get liberty, as he conceived, by flying to lord Dunmore.”5 

The number of slaves that actually joined the British is questionable. Dr. Quarles 
estimates that it may have been about 800. It should be noted, however, that other historians now 
suggest that this figure may be conservative. Accounts from the period support the view that 
there may have been considerably more. Robert Carter Nicholas, president of the Virginia 
Convention, wrote to the Virginia delegates in Congress that “many of our Natives it is said have 
been intimidated and compelled to join them [the British] and great Numbers of Slaves from 
different Quarters have graced their Corps.” The British, he continued, were “using every Art to 
seduce the Negroes.”6 Edmund Pendleton wrote to Richard Lee, “letters mention that slaves 
flock to him [Dunmore] in abundance; but I hope it is magnified.” Even George Washington 
warned, “Dunmore should be instantly crushed…otherwise, like a snowball rolling, his army will 
get size.”7 

The decision to join Dunmore and support the British cause must have created 
tremendous debate and concern throughout the slave community. What factors influenced 
whether or not a slave’s allegiance was given to the British or to the colonists? There are a 
variety of possible answers. It is likely that the desire for freedom was so overwhelming that the 
slaves seized the first viable offer. It is also possible that the slaves wanted to show that they 
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were worthy of respect and the rights of citizenry by remaining faithful to the authority of the 
British government. On the other hand, how does one explain the numbers of blacks, such as 
Salem Poor, Oliver Cromwell, and Peter Salem, who wholeheartedly supported the colonists? 
Were their reasons for supporting the American cause the same as those of white patriots? 
Possibly. After learning of the death of Crispus Attucks, a free black killed in the Boston 
Massacre in March 1770, the colonists revered him for having lost his life for liberty. But the 
slaves must have surely asked, whose liberty? Even as free blacks, the full rights of citizenry 
were denied African-Americans. Generally, they were still subject to the same curfews and laws 
that applied to slaves. The only difference between free blacks and slaves in the eighteenth 
century was that free blacks had the right to own and protect property. 

The decision to join the British or support the patriots was one that surely split some 
slave families and friendships, just as it did the white citizenry. The American Revolution, for all 
intents and purposes, was a civil war, one that affected every member of society in some way. 
 
_____________________________ 
 
 2Gerald W. Mullin, Flight and Rebellion: Slave Resistance in Eighteenth-Century 
Virginia (New York, 1972), p. 131. 
 
 3Early in the morning of April 21, 1775, British sailors and marines acting on orders from 
Governor Dunmore removed gunpowder from the public Magazine in Williamsburg. Angry 
citizens quickly gathered in Market Square. Only the intervention of moderate political leaders 
such as Speaker of the House of Burgesses Peyton Randolph, Williamsburg Mayor John Dixon, 
and treasurer of the colony Robert Carter Nicholas prevented the angry populace from attacking 
the Governor’s Palace. 
 
 4Benjamin Quarles, “The Revolutionary War as a Black Declaration of Independence,” in 
Ira Berlin and Ronald Hoffman, eds., Slavery and Freedom in the Age of the American 
Revolution (Charlottesville, Va., 1983), pp. 292-293. 
 
 5Virginia Gazette (Purdie), Nov. 17, 1775. Supplement. 
 
 6Letter dated Nov. 25, 1775, quoted in Robert L. Scribner and Brent Tarter, eds., 
Revolutionary Virginia and the Road to Independence, IV: The Committee of Safety and the 
Balance of Forces, (Charlottesville, Va., 1978), p. 470. 
 
 7Pendleton to Lee, Nov. 27, 1775, quoted in Mullin, Flight and Rebellion, p.131; 
Washington to Joseph Reed, Dec. 15, 1775, quoted ibid. 
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TRANSCRIPTION OF DUNMORE’S PROCLAMATION 
 
 
By His Excellency the Right Honorable JOHN Earl of DUNMORE, His Majesty’s Lieutenant 
and Governor General of the Colony and Dominion of Virginia, and Vice Admiral of the same: 
 

A    P  R  O  C  L  A  M  A  T  I  O  N. 
 
As I have ever entertained Hopes that an Accommodation might have taken Place between Great 
Britain and this colony, without being compelled, by my Duty, to this most disagreeable, but 
now absolutely necessary Step, rendered so by a Body of armed Men, unlawfully assembled, 
firing on his Majesty’s Tenders, and the Formation of an Army, and that Army now on their 
March to attack his Majesty’s Troops, and destroy the well-disposed Subjects of this Colony: To 
defeat such treasonable Purposes, and that all such Traitors, and their Abettors, may be brought 
to Justice, and that the Peace and good Order of this Colony may be again restored, which the 
ordinary Course of the civil Law is unable to effect, I have thought fit to issue this my 
Proclamation, hereby declaring, that until the aforesaid good Purposes can be obtained, I do, in 
Virtue of the Power and Authority to me given, by his Majesty, determine to execute Martial 
Law, and cause the same to be executed throughout this Colony; and to the End that Peace and 
good Order may the sooner be restored, I do require every Person capable of bearing Arms to 
report to his Majesty’s STANDARD, or be looked upon as Traitors to his Majesty’s Crown and 
Government, and thereby become liable to the Penalty the Law inflicts upon such Offences, such 
as Forfeiture of Life, Confiscation of Lands, &c. &c. And I do hereby further declare all 
indentured Servants, Negroes or others (appertaining to Rebels) free, that are able and willing to 
bear Arms, they joining his Majesty’s Troops, as soon as may be, for the more speedily reducing 
this Colony to a proper Sense of their Duty, to his Majesty’s Crown and Dignity. I do farther 
order, and require, all his Majesty’s liege Subjects, to retain their Quitrents, or any other Taxes 
due or that may become due, in their own Custody, till such Time as Peace may be again restored 
to this at present most unhappy Country, or demanded of them for their former salutary 
Purposes, by Officers properly authorised to receive the same. 
 
GIVEN UNDER MY Hand, on Board the Ship William, off Norfolk, the 7th Day of November, 
in the sixteenth Year of his Majesty’s Reign. 
          DUNMORE 
GOD SAVE THE KING. 
 
 
Source: Original document on file in the Tracy W. McGregor Library, University of Virginia. 
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A LETTER TO THE VIRGINIA GAZETTE REGARDING 
DUNMORE’S PROCLAMATION 

 
The second class of people, for whose sake a few remarks upon this proclamation seem 

necessary, is the Negroes. They have been flattered with their freedom, if they be able to bear 
arms, and will spedily join Lord Dunmore’s troops. To none then is freedom promised but to 
such as are able to do Lord Dunmore service: The aged, the infirm, the women and children, are 
still to remain the property of their masters, masters who will be provoked to severity, should 
part of their slaves desert them. Lord Dunmore’s declaration, therefore, is a cruel declaration to 
the Negroes. He does not even pretend to make it out of any tenderness to them, but soley on his 
own account; and should it meet with success, it leaves by far the greater number at the mercy of 
an enraged and injured people. But should there be any amongst the Negroes weak enough to 
believe that Dunmore intends to do them a kindness, and wicked enough to provoke the fury of 
the Americans against their defenceless fathers and mothers, their wives, their women and 
children, let them only consider the difficulty of effecting their escape, and what they must 
expect to suffer if they fall into the hands of the Americans. Let them farther consider what must 
be their fate, should the English prove conquerors in this dispute. If we can judge of the future 
from the past, it will not be much mended. Long have the Americans, moved by compassion, and 
actuated by sound policy, endeavoured to stop the progress of slavery. Our Assemblies have 
repeatedly passed acts laying heavy duties upon imported Negroes, by which they meant 
altogether to prevent the horrid traffick; but their humane intentions have been as often frustrated 
by the cruelty and covetousness of a set of English merchants, who prevailed upon the King to 
repeal our kind and merciful acts, little indeed to the credit of his humanity. Can it then be 
supposed that the Negroes will be better used by the English, who have always encouraged and 
upheld this slavery, than by their present masters, who pity their condition, who wish, in general, 
to make it as easy and comfortable as possible, and who would willingly, were it in their power, 
or were they permitted, not only prevent any more Negroes from losing their freedom, but 
restore it to such as have already unhappily lost it. No, the ends of Lord Dunmore and his party 
being answered, they will either give up the offending Negroes to the rigour of the laws they 
have broken, or sell them in the West Indies, where every year they sell many thousands of their 
miserable brethren, to perish either by the inclemency of the weather, or the cruelty of barbarous 
masters. Be not then, ye Negroes, tempted by this proclamation to ruin yourselves. I have given 
you a faithful view of what you are to expect; and I declare, before GOD, in doing it, I have 
considered your welfare, as well as that of the country. Whether you will profit by my advice I 
cannot tell; but this I know, that whether we suffer or not, if you desert us, you most certainly 
will. 
 
 
Source: Virginia Gazette (Dixon and Hunter), Nov. 5, 1775.
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Using the TI-Navigator™ System 
with this Lesson 

 
 
Introduction 
 
This document provides ideas about how the lesson you have chosen can be enhanced by using 
the TI-Navigator™ Classroom Learning System. Read further to learn about: 

♦ Enhancing Your Lessons with the TI-Navigator™ System 

♦ Sending Files to Your Class 

♦ Receiving and Viewing LearningCheck™ Results From Your Students 

♦ Using LearningCheck™ Results 

 
Notes:  
 
Detailed instructions for specific TI-Navigator™ tasks are available in the Getting Started Guide 
that accompanies the System. 
 
The examples provided in this document will not necessarily match the text you see on your 
computer or device. They are provided as a guideline for using the hardware and software. 
 

  

© 2003 Texas Instruments Incorporated 
 

8 



  

 

Enhancing Your Lessons with the TI-Navigator™ System 
♦ Use the TI-Navigator System to efficiently send Notefolio™, LearningCheck™, 

StudyCards™, CellSheet™, and TImeSpan™ files to students, to save time and paper. 

♦ Use the Notefolio™, LearningCheck™, TImeSpan™, or StudyCard™ Creator or the 
CellSheet™ Converter software to modify any of the ready-made lesson files to better fit 
the needs of your students. 

♦ Use the TI-Navigator™ System and LearningCheck™ Application to measure student 
understanding at any point during a lesson. To do this, use the LearningCheck™ Creator 
software to make an assignment using a variety of questioning types such as Likert Scale 
(shown below), Yes/No, Agree/Disagree, and so forth. This technique is an excellent way 
to spark lively class discussions. 

 

 

♦ Use either the Notefolio™ or LearningCheck™ Application to efficiently send student 
instructions, saving time and paper. 

♦ Use the NoteFolio™ or LearningCheck™ Creator software to modify any of the ready-made 
lesson resource files to better fit the needs of your students. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Likert Scale Question 
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Sending Files to Your Class 
 
Most lessons begin with a ready-made file (called an Application Variable or AppVar for short), 
such as a LearningCheck™ file, that you distribute to the class. Using the TI-Navigator™ 
System, you can quickly send these files to the whole class at one time. This eliminates the need 
for students to use the unit-to-unit cables to distribute the files, thus saving valuable class time. 
With the TI-Navigator™ System, any student who arrives late to class can obtain their file with 
minimum disruption to the class. 
 
Creating and Sending LearningCheck™ Files 
 
Since the LearningCheck™ Creator software is a part of the TI-Navigator™ System, you can 
quickly check student comprehension during a lesson by creating a file with one or two 
questions, and then sending it to the class. Use the following procedure to send a newly created 
file using the TI-Navigator™ System.  

1. On the computer, click Start > Programs > TI-Navigator > TI Navigator. The 
TI-Navigator™ System Home screen opens. 

2. Click the LearningCheck™ button on the left to launch the LearningCheck™ Creator 
program. Create the new assessment or assignment. 

Note: Instructions for using the LearningCheck™ Creator are available with the creator 
software. 

3. When the file is completed, click File > Send to > Class. An alternate method of sending 
files is to click on the Send to Class icon.  
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The Transfer window opens, letting you see the progress of the files as they are sent to your 

class. 

 
Window with Transfer In Progress 

 

4. When the Status column shows Done for all the devices in your classroom, click Done. 

5. Click File > Close to close the LearningCheck™ Creator. Click No when asked whether to 
save your document. Each student has the new file. 
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Sending Existing Files 
 
If you have AppVars (LearningCheck™, CellSheet™, or NoteFolio™ files) already created and 
saved, you can send these to a class without opening the creator software.  

1. Start the TI-Navigator™ System. Select the Edit menu. 

2. Select Add To Transfer List from the Edit menu options. 

 
A box opens that enables you to type the name of the file you want added to the transfer list. If 

you do not know the path and name of the file, click the browse icon to the right of the file 
name box. 
 

 
 

   Add to Transfer List Box with Browse Button Indicated 
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3. If you choose to search for your files, a window opens that enables you to search for the 
AppVars (files) you want to send to the class. Note that these must be device-specific 
AppVars (such as .8xv files), not creator files such as the .edc files from LearningCheck™ 
Creator.  

 
Browse for Files Box 

 
4.  Double-click the mouse button to enter the name of the file in the File Name field.  

 
Selected File entered 
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5. Click Continue. A Properties window opens before each file is added. This box informs you 

of the target destination and estimated size of the file on the device.  

 
   Send to Class Properties Box 

 

6. Click OK to add a file to the list. Repeat these steps to add all AppVars files you want to 
transmit to the class.  

 
 During class, you can send specific files to the class by clicking the checkbox at the far left 

of the file name in the Class Connect section of the TI-Navigator™ screen. (This is a 
toggle—turn the check mark on/off by clicking on the box. See the example below.)  

 
Send to Class file list (note green Start Transfer button) 

 

 To send the selected file(s), click the Start Transfer button that appears just above the 
Properties column heading. The Transferring window opens and shows the progress of the 
file transfers. When the Status column shows Done for all the devices in your classroom, 
click Done. 
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Receiving and Viewing LearningCheck™ Results from Your Students 
 
Whenever a lesson requires students to send you their completed LearningCheck™ files, you can 
retrieve the file from the entire class almost instantaneously with the TI-Navigator™ System. 
(Refer to the TI-Navigator™ System Getting Started Guide for information on retrieving and 
viewing other file types.) 
 
Use the Class Analysis tool to receive and view results from completed student 
LearningCheck™ files. Access it by clicking the icon in the left bar of the TI-Navigator™ Home 
screen.  
 
With the Class Analysis tool opened, if you select Collect From Class, the system is 
automatically ready to retrieve the last LearningCheck™ file sent to the students. When file 
collection is completed, the system populates the Class Analysis File with the students’ data.  

 
 

 

      Class Analysis Icon TI-Navigator™ Window Showing File to be Collected 
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Using LearningCheck™ Results 
 
The Class Analysis tool does more than just allow you to quickly retrieve student files. Once you 
have retrieved a set of LearningCheck™ assignments, the software enables you to analyze the 
results of the assignment. With the Class Analysis tool, you have the ability to view and print 

♦ A summary for all students and all questions (responses per question),  

♦ A single student’s results,   

♦ A single item’s responses (item analysis). 

Class Analysis also allows you to display student responses anonymously, allowing you to 
conduct stimulating class discussions based on what was answered instead of who answered 
what. 

 

Class Analysis Slide Show of Results 
 

 Question To Which Students Responded The Responses for Each Response Option 
 
 
For More Information 
 
For more information about the TI-Navigator™ System, go to education.ti.com and click on the 
link for the TI-Navigator™ System.
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*     *     *     *     *     *     * 
 
This TI-83 Plus lesson was adapted from Slavery: A Colonial Odyssey, a lesson unit available 
from the Colonial Williamsburg Foundation. For more information on this lesson unit and other 
Colonial Williamsburg instructional materials and classroom resources, visit 
http://www.history.org/teach, or call 1-800-688-6473. 
 
Special thanks for developing this lesson go to: 
Janet P. Brooks, AP U.S. History teacher, Liverpool High School, Liverpool, NY 
Charles R. Coon, Adjunct Professor of Education, State University of New York at 
 Oswego, Oswego, NY 
Bob Van Amburgh, Instructional Supervisor for Social Studies, City School District of 
 Albany, NY 
Kathryn Robinson, teacher and Texas Instruments T3 Instructor, Parkville High School, 
 Baltimore, MD 
Colonial Williamsburg Foundation Department of Education Outreach staff  
Texas Instruments staff 
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